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DRAFT
Grant Payment Request & Worksheet
Form 8700-001 (R 08/23)
Form 8700-006   (R 08/23)
DRAFT
Grant Payment Request & Worksheet
Certification:  This payment request cannot be processed unless this form is signed by the authorized representative named in your resolution.  Questions?  Contact your DNR grant specialist identified in the cover letter that came with your grant agreement.  Or, go to the DNR web page for the grant program http://dnr.wi.gov/Aid/Grants.html and click on the Help tab.
Form 8700-001 (R 08/23)
DRAFT
Grant Payment Request & Worksheet
Form 8700-001 (R 08/23)
DRAFT
Grant Payment Request & Worksheet
Form 8700-001 (06/18)
DRAFT
Grant Payment Request & Worksheet
Form 8700-001 (R 08/23)
Form 8700-006   (R 04/16)
DRAFT
Grant Payment Request & Worksheet
Certification:  This payment request cannot be processed unless this form is signed by the authorized representative named in your resolution.    Questions?  Contact your DNR grant specialist identified in the cover letter that came with your grant agreement.  Or, go to the DNR web page for the grant program http://dnr.wi.gov/Aid/Grants.html and click on the Help tab.  
Form 8700-001 (R 08/23)
<body xmlns="http://www.w3.org/1999/xhtml" xmlns:xfa="http://www.xfa.org/schema/xfa-data/1.0/"><p style="font-family:'Times';font-size:12pt;letter-spacing:0in"><span style="xfa-spacerun:yes"> </span></p><p style="font-family:'Times';font-size:12pt;letter-spacing:0in">The document you are trying to load requires Adobe Acrobat Reader. You may be using a non Adobe PDF Viewer or an old version of Adobe Reader. Save this file; open Adobe Reader; select File > Open and browse to select and open your saved file. You can upgrade to the latest version of Adobe Reader for Windows, Mac, or Linux by visiting <span style="xfa-spacerun:yes"> </span>http://www.adobe.com/go/reader_download.</p><p style="font-family:'Times';font-size:12pt;letter-spacing:0in"><span style="xfa-spacerun:yes"> </span></p><p style="font-family:'Times';font-size:12pt;letter-spacing:0in">For more assistance with Adobe Reader visit <span style="xfa-spacerun:yes"> </span>http://www.adobe.com/go/acrreader.</p></body>
Note:         In order to fill and save this form electronically, it must be opened using Adobe Reader or Acrobat software.Save a copy of the file, open Adobe Reader, select File > Open and browse for the file you saved.
This electronic file can be saved and attached to an email. Refer to the job announcement for submittal instructions.
State of Wisconsin
Department of Natural Resources
Box 7921
Madison, WI 53707-7921
State of WisconsinDepartment of Natural ResourcesBox 7921Madison, WI 53707-7921
Notice:  Grantees are required to provide information requested on this form when applying for payment of a grant funded by the Department.  The Department will not process your payment unless you provide all information requested.  This information will be used to determine the amount of your payment and to issue your check.  Personally identifiable information collected will be used for program administration and may be made available to requesters as required under Wisconsin's Public Records Law [ss. 19.31-19.39, Wis Stats.].
Submit one copy of the completed Grant Payment Request & Worksheet form, and required documentation, listed on reverse, to your DNR Grant Specialist.  See the DNR web site for additional information: http://dnr.wi.gov/Aid.  
Grantee and Project Information - This section must be filled out entirely in order to complete the rest of the form.
Type of Request
Type of Request:
Is this a land acquisition project? 
Select employment status:  full or part-time
Will in-kind donations be applied to this request?
Did you receive a grant advance or escrow?
Select employment status:  full or part-time
Select if part-time
Is this your first payment request after an advance payment?
Select if part-time
The DNR will mail the check to the name identified on the application as the “Check Recipient.”  Contact your DNR Grant Specialist with questions.
Cost Share Summary
Enter the percent state cost share listed in your grant agreement or identified in your approved grant application.
%            
%	
A. Payment Record to Date
Amount
Amount
This Column for DNR Use Only
This Column for DNR Use Only
 3.  Total State Aid Amount (from Grant Agreement)                   
1.	Amount of Grant (from original or amended Grant Agreement) 
 4.  Total Payments Received (including Advance or Escrow)    
2.c.	Total Payments Received to Date (Lines 2.a. + 2.b.)
 5.  Funds Remaining                                                                                   
3.	Funds Remaining (Line 1 minus Line 2.c.)
Payment Record to Date
4.  Requested State Share of Costs                     G24     ( G28*G14)
1.	Amount of Grant (from original or amended Grant Agreement) 
5.  Requested Grantee Share of Costs                G25      ( G28-G22)
2.c.	Total Payments Received to Date (Lines 2.a. + 2.b.)
Reimbursement Request (this section for calculation purposes only)
Payment Information (see reverse for instructions)
Total Eligible Project Costs this Period. Transferred from Worksheet (8700-002)                                                      G23    (D63)
Reimbursement Calculation
Information in this section is transferred from the Grant Payment Worksheet, page 3.  Complete the Worksheet next.  Note: Grant payment may not exceed the amount expended by the grantee as shown in the Cash Paid column of the Worksheet, and may not exceed the funds remaining in line 5 above.  This calculation will adjust the state share and the grantee share for these conditions.
 7.  State Share of Costs				
 8.  Grantee Share of Costs                                                       
2.c.	Total Payments Received to Date (Lines 2.a. + 2.b.)
 6.  Total Eligible Project Costs this Period. Transferred from Worksheet                                                   
Reimbursement Amount
The amount paid cannot exceed the cash costs less the advance or the funds remaining (line 5).  See “Instructions” for details on how the advance amount is accounted for when calculating the amount eligible this claim (line 9).
 9.  Amount Eligible this Claim                                                        
10.  Grant Balance Remaining                                                      
2.c.	Total Payments Received to Date (Lines 2.a. + 2.b.)
In-kind Donation Summary				   For
11.  In-kind donations applied to this claim                                    
12.  Remaining In-kind donations applied to next claim for this grant     
2.c.	Total Payments Received to Date (Lines 2.a. + 2.b.)
Lake & River Grants Only:  Does project include State Lab of Hygiene Sample Analysis?  
Lake & River Grants Only:  Does project include State Lab of Hygiene Sample Analysis?  
Lake & River Grants Only:  Does project include State Lab of Hygiene Sample Analysis?
Certification
I certify that, to the best of my knowledge and belief, the eligible costs requested are in accordance with the terms of the grant agreement and that all expenditures are based on actual payments of record.  This reimbursement represents the grant share due that has not been previously requested.
I certify that, to the best of my knowledge and belief, the eligible costs requested are in accordance with the terms of the grant agreement and that all expenditures are based on actual payments of record.  This reimbursement represents the grant share due that has not been previously requested.
Space Below this Line for DNR Use Only
Space Below this Line for DNR Use Only
INSTRUCTIONS
Grantee and Project Information
Identifies information about the grantee and project.  Each field in this section must be completed before you will be able to complete the other sections of the form.  Notes: 1. In-kind donations are defined as goods and services which have been provided to the project at no cost to the grantee and have documented value.  Examples include donated services, equipment, land, and volunteer labor. 2. If this is your first time submitting documentation of grant expenses, answer “yes” it is your first payment request. 
Cost Share Summary
Line 1: State Cost Share Percentage.  Enter this amount from your grant agreement.
Line 2: Grantee Cost Share Percentage.  This amount will auto-calculate.
Payment Record to Date
Line 3: State Aid Amount.  Enter this amount from your grant agreement.
Line 4: If you answered “Yes” to question about receiving a grant advance or escrow and “Yes” to this being the first payment after receiving your advance or escrow, then enter the advance or escrow amount on Line 4.  
If you answered “No” to question about receiving a grant advance or escrow, or “No” to this being the first payment, enter onto Line 4 the total value of all payments received to date (include any advance or escrow received).  
Line 5: Funds Remaining.  This amount will auto-calculate as the difference between Lines 3 and 4. 
Complete the “Grant Payment Worksheet”, page 3, next.  Follow these instructions to complete the Worksheet.  
Reimbursement Calculation
Do not fill in this portion of the document.  Amounts will either transfer from the Worksheet or auto-calculate. 
Line 6: Total Eligible Project Costs this period.  This amount will transfer from the Grant Payment Worksheet, page 3, and is the total of all eligible expenses claimed in the current payment request.  
Line 7: State Share of Costs.  This is the portion of project costs for which the state is responsible.  This amount is the State Cost Share Percentage, Line 1, multiplied by the Total Eligible Project Costs, Line 6.  This amount is limited to the funds remaining in the grant, Line 5, or the amount expended by the grantee as shown in the Cash Paid column of the Grant Payment Worksheet.  If this is the first payment request after receiving an advance or escrow, this amount may exceed the funds remaining, Line 5, if the amount eligible to be reimbursed after subtracting the advance amount is less than the funds remaining in line 5.  This form will automatically adjust for these conditions.
Line 8: Grantee Share of Costs.  This amount is the difference between the Total Eligible Project Costs and the State Share of Costs.  
Approved Reimbursement Amount
Line 9: Amount Eligible this Claim.  This is the amount that grantee is claiming in this reimbursement request. 
Line 10: Grant Balance Remaining.  This amount will auto-calculate as the difference between the Funds Remaining, Line 5, and Amount Eligible this Claim, Line 9. 
(
 
×State Share of Costs
 )
In-Kind Donation Summary
If you answered “Yes” to the question about in-kind donations being applied to this request, a summary of the value of donation applied as grantee match will be included on page 1, the Grant Payment Request.
Line 11: In-Kind Donations Applied to Claim.  If more donations were applied to this claim than needed to meet the Grantee’s share of costs, then in-kind donations applied to this claim is automatically calculated as follows:
In Kind Donations Applied = 
                  Grantee Cost Share % 
                      State Cost Share %   
Line 12: Remaining In-Kind Donations.  For some grant programs remaining in-kind donations may be applied to the next reimbursement request in the same grant agreement.  On the next reimbursement request, you will need to enter the value from Line 12 of this worksheet into the “In-Kind Donations” column on the worksheet of the next payment request.  Include a project cost description of “remaining in-kind donations from the previous reimbursement”.  Ask your DNR grant specialist if you are eligible to use remaining in-kind donations on future reimbursement requests for the grant. 
REQUIRED DOCUMENTATION
Attach to the completed form one copy of the following documents as required by your grant program.
FOR LAND ACQUISITION PROJECTS:
1. Copy of recorded deed.
2. Copy of title insurance policy.
3. Copy of Gap insurance
4. Closing statement/canceled check(s).
5. Offer to purchase.
6. Proof of Just Compensation.
7. Statement of relocation payments, if any.
8. WI Department of Commerce relocation statement, if any.
9. Statement of program revenue; i.e., sale of buildings, etc.
FOR DEVELOPMENT PROJECTS:
1. Copy of invoices, vouchers and canceled checks.
2. Copy of bid specifications, certified bid tabulations, accepted bid proposal(s), contracts and change orders. 
3. Force account labor/equipment records.
4. Donation labor/equipment records.
5. Copy of affidavit of publication or bid notice.
FOR MAINTENANCE PROJECTS:
1. Copy of vendors invoices, vouchers and canceled checks.
2. Copy of bid specifications, certified bid tabulations, accepted bid.
REPORTING REQUIREMENTS:
Use of this form is authorized either by Wis. Stats. or the Act for Federal Grant Programs.  To view the exact citation, either go to the DNR web page for the grant program in question 
http://dnr.wi.gov/Aid/Grants.html or see page one of the grant agreement. 
Notice: Information requested on this worksheet is required by the Department when applying for reimbursement of eligible expenses.  The Department will not consider your payment request unless you complete and submit this form and any required documentation.
Instructions: Itemize all project expenses, including donated labor, and attach photocopies of proof of expenses for each item listed.  See reverse for instructions.  Add additional lines to the worksheet as necessary, and number each printed worksheet.  Submit with page 1 of the Grant Payment Request, Form 8700-001, or specific grant reimbursement form, to your DNR Grant Specialist.
State of Wisconsin
Department of Natural Resources
Community Financial Assistance
Does this grant project include State Lab of Hygiene sample analysis costs?
Select employment status:  full or part-time
GRANT PAYMENT WORKSHEET
Date Expense Incurred
Date Expense Incurred
Invoice #
Invoice #
Proof of Payment #
Proof of Payment #
Payee
Payee
Eligible Project Cost Description 
Eligible Project Cost Description(Check Grant Agreement)
Cash Paid
Amount Paid
In-kind Donations
Amount Donated
Use the worksheet to itemize all project costs, including value of donated labor and donated expenses.
Attach photocopies of proof of purchase and payments for each  item listed.
Add additional lines to worksheet as necessary by clicking on the “+” symbol located in the lower right corner of the Grant Payment Worksheet, page 3. 
Use the worksheet to itemize all project costs, including value of donated labor and donated expenses.
Attach photocopies of proof of purchase and payments for each   item listed.
Add additional lines to worksheet as necessary by clicking on the “+” symbol located in the lower right corner of the Grant Payment Worksheet, page 3. 
Worksheet Definitions
Date Expense Incurred: Date of invoice, purchase, or service rendered.  Costs incurred prior to the beginning date or after the ending date of the grant agreement are not eligible for reimbursement, except as noted below.
• Exceptions: Certain land acquisition, design costs, and navigational aids may be reimbursable retroactively. Check with your DNR Grant Specialist.
Invoice #: Number on vendor invoice or bill associated with the purchase or service.
• Combined Costs: If an invoice combines costs for multiple grants or expenses, identify and explain specific costs associated with each grant expense. Attach a copy of this invoice, as well as proof of payment identified below. Use as many lines as necessary.
• Donated Expenses: Include invoice number if donated expenses are included on an invoice or bill. Otherwise, leave this field blank and go to "Proof of Payment #" column.
Proof of Payment #: Number on check or money order used to pay the expense. If no proof of payment number, leave blank. Attachments required:
• Proof of Payment Examples:
         ·         Copy of canceled check (both sides) showing the amount of the check digitally printed by the bank under the signature line
         ·         Non-cancelled check with bank statement showing check cleared account
         ·         Copy of bank statement with vendor name and amount highlighted
         ·         County payroll vouchers
         ·         Credit card statement with supply or service vendor name and amount highlighted
         ·         Receipts
         ·         For acquisition expenditures, include a copy of the acquisition closing statement
• Combined Proofs of Payment: If a proof of payment covers multiple expenses or grants, identify payments related to the particular grant expense.
• Note: Redact (blacken out) account information submitted with proof of payment documentation.
• Donated Expenses: Volunteer Labor Worksheet, or other donated labor/services documentation. Include volunteer names, type of work, hours worked, pay rate and totals. Labor worksheets require signatures of volunteer(s) and supervisor(s).
Payee: Name of consultant, contractor, vendor, supplier, etc. to whom payment was made.
Eligible Project Cost Description (See Grant Agreement): Describe expense briefly. Include only eligible expenses as specified in the particular project grant application and grant agreement.Cash Paid: The amount of the project cost expense paid out-of-pocket by the grantee. Enter only actual expenditures in this column.
In-kind Donations: The value of donated services, labor, equipment usage, etc. Enter donated values in this column.Paid Subtotal:  The sum of all paid expenditures listed in that column.Donated Subtotal:  The sum of the value of each donated item listed in the column.  Total Project Costs: (Paid Subtotals all pages) + (Donated Subtotals all pages) = Total Project Costs
• Automatically calculated and transferred to Page 1, Line 6 “Total Eligible Project Costs This Period” when form is completed electronically.
8.2.1.3144.1.471865.466429
DNR
State of Wisconsin Department of Natural Resources
Form 8700-001
 Kozik, Christine R - DNR
Grant Payment Request & Worksheet

(R 08/29/23)
(R 6/17)
Type of Request
Partial
Type of Request
Final
Is this a land acquisition project? 
Yes
2
Is this a land acquisition project? 
No
Will in-kind donations be applied to this request?
Yes
Will in-kind donations be applied to this request?
No
Did you receive a grant advance or escrow?, Yes
Did you receive a grant advance or escrow?, No
Is this your first payment request after an advance payment?, Yes
Is this your first payment request after an advance payment?, No
Is this your first payment request after an advance payment?
 3. Total State Aid Amount (from Grant Agreement)  
 4.  Total Payments Received (including Advance or Escrow)
 4.  Total Payments Received (including Advance or Escrow)
 5. Funds Remaining	 		 			 
4. Requested State Share of Costs G24 ( G28*G14)
5. Requested Grantee Share of Costs G25 ( G28-G22)
Total Eligible Project Costs this Period. Transferred from Worksheet (8700-002)  G23  (D63)
 7.  State Share of Costs				
 8. Grantee Share of Costs 		 
 6. Total Eligible Project Costs this Period. Transferred from Worksheet 
 6. Total Eligible Project Costs this Period. Transferred from Worksheet 
 9. Amount Eligible this Claim 			  
10. Grant Balance Remaining 			 
11. In-kind donations applied to this claim 		  
12. Remaining In-kind donations applied to next claim for this grant 
Does this grant project include State Lab of Hygiene sample analysis costs?
Yes
Does this grant project include State Lab of Hygiene sample analysis costs?
No
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
Date Expense Incurred
Invoice #
Proof of Payment #
Payee
Eligible Project Cost Description 
Cash Paid
In-kind Donations
WORKSHEET INSTRUCTIONS
Page 1 of 4
Page 2 of 4
Page 3 of 4
Page 4 of 4
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